
YBK   essentials



REP
Design ideas, including cover and theme
Curriculum and training
Sample books
Staff organization
Pricing questions

CSA (CUSTOMER SERVICE)
Deadline information
Shipping information
Turning on cover templates

TSA (TECH SUPPORT)
Assistance with book setup
eDesign and eBusiness setup
Submitting pages
Uploading portrait CDs

WHO 
TO 
CALL

THEY’VE GOT YOUR BACK,  
SO ALWAYS HAVE THEIR 
CONTACT ON HAND.

YEARBOOK REPRESENTATIVE (REP)

Name: 

Email: 

Phone: 

CUSTOMER SERVICE ADVISER (CSA)

Name: 

Email: 

Phone: 800-255-6287

TECHNICAL SUPPORT ADVISER (TSA)

Phone: 877-362-7750 

Live chat through eDesign

SCHOOL PHOTOGRAPHER

Name: 

Email: 

Phone: 

DETAILS TO KNOW BEFORE YOU CALL YOUR TSA OR CSA:

Job number: 
Your school has a unique number to identify your files 
within the plant so they can find you easily. 

Operating system: 
What type of computers does your staff use and what platform?

Web browser: 
Which web browser do you use? They all operate differently, 
so knowing your preferred browser will help answer questions.

eShare code: 
This code is for students to use while sharing photos for the book.

WHAT CAN 
THEY HELP 
YOU WITH?



MYHJYEARBOOK.COM 

MYHJYEARBOOK.COM 

LEARNYBK.COM

BOOKMARK 
IT KNOW WHERE TO FIND 

EVERYTHING YOU NEED ONLINE 
TO CREATE YOUR BOOK

MYHJYEARBOOK .COM LOGIN CREDENTIALS

My username: 

My password: 

MYHJYEARBOOK.COM
This is your portal to all things yearbook, including eDesign 
and eBusiness. This site gives you easy access to book sales 
and other critical information.

LEARNYBK.COM
Here’s a shortcut to the online curriculum, which serves 
as a companion to our 12-booklet How to Yearbook printed 
curriculum. It is also accessible through the Learn menu on 
myHJYearbook.com.

HJESHARE.COM
Also available as an app, eShare is an easy way for parents and 
students to share photos with you.

YEARBOOKORDERCENTER.COM
Customized for your school, this is where students and 
parents order yearbooks and ads, access Online Ad Creator 
and upload photos. If you use the order center, remember to 
include the address on your sales posters.
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WELCOME.
We strive to make yearbook easy 
and straightforward. While there’s 
a lot to do, we’ve gathered the most 
critical get-it-done information into 
this handy guide. Follow this, and 
you’ll be in great shape. 

We know that yearbook programs 
come in all forms  — clubs, classes 
large and small. Sometimes, it’s 
just one brave soul, trying to put 
together the events of the year 
alongside all of those school 
pictures. We also know that as 
a yearbook adviser, you’ve got 
plenty of other important tasks to 
keep you busy. We get you, and we 
support your choice to do only as 
much as you choose. We’re here to 
help you break your jobs into bite-
sized pieces and focus on making a 
fun, creative yearbook your school 
can be proud of. 



WE’RE 
GLAD 

YOU’RE
 HERE.

1 — ES SEN T I A L T O - DOS  p. 5
Each school and situation is a little 
different. Here are four easy ways to 
make sure you are in the know and 
ready to plan your yearbook.

2 —P RODUC T ION B A SIC S p. 7
Look for the yellow headlines for a 
beginner’s course to handling the 
basics of yearbooking, like uploading 
portraits and photos, designing 
pages and submitting them when 
you’re ready. There’s more support in 
our curriculum and online, but this is 
a great place to start.

3 —NE X T- L E V EL GO A L S  p. 1 4
If you have a club or a class, here 
are our suggestions for building a 
yearbook program that works for you 
and your school.
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1.  GET STUDENT AND FACULT Y NAME LISTS
Ask for a new list each year from your administrative 
office, and make sure it reflects new students, address 
changes, etc. Your school photographer will need this list, 
and if you use eBusiness or want to send email campaigns, 
you’ll need it, too. Request the following fields (not all are 
required, but could be helpful): 

• REQUIRED: First and last names (in separate fields; 
middle name is optional)

• REQUIRED: Grade 

• Full mailing address (separate fields for address line 
one, two, city, state or province and ZIP or postal code)

• Homeroom or identifying class period

• Student ID or some unique identifier

• Parent email address

Also, get a list of faculty and staff members. Request the 
following fields:

• First, middle and last names (in separate fields)

• STA for staff or FAC for faculty in the grade field 

TROUBLESHOOTING:
If your front office questions your need for the student list, 
provide them with our FERPA policy, or PIPEDA/FIPPA 
policy if you’re in Canada, included as a separate sheet in 
the kit. This explains how Herff Jones is in compliance with 
laws related to using student information.

UPLOAD YOUR NAME LIST
Log in at myHJyearbook.com.
Go to Setup > Setup Sales.
Then click the Name List tab on the left.

IMPORT LIST TO EDESIGN
Log in at myHJyearbook.com.
Go to Setup > Book Setup.
In the Master List tab, import your list to eDesign.
Note: It may take up to 15 minutes for your name 
list to be available in eDesign after uploading to 
eBusiness.

If you need help, access the video tutorials under 
the Learn menu. And, if you really run into trouble, 
call your TSA for assistance.

2. PL AN YOUR FINANCES
Refer to How to Yearbook and LearnYBK.com Section 11: 
Selling Your Book.

BUDGET

• Do you have a budget from the previous year?

• Set the yearbook price for parents and prices of add-
ons, such as personalization.

BOOK SALES

• Do you sell books? If so, how many were sold  
last year? Account for books you give away, too.

• What price structure will you follow? Will you  
have one price all year or tiered pricing?

• How will you promote your book?

AD SALES

• Will you sell ads to families, students and/or 
businesses?

• What price structure will you follow?

• How will you accomplish ad sales?

 
Once you get through all of the decisions for book and 
ad sales, you can set up eBusiness, a powerful business 
tracking software available only from Herff Jones. Go to 
MyHJyearbook.com and click on Setup. Ask your rep  
or your TSA for help as needed. 

3. KEEP A MASTER CALENDAR
Make the rounds and find all of the dates that affect your 
school and your yearbook production schedule.

INCLUDE ON MASTER CALENDAR:

• Book sales events

• Picture day(s)

• Make-up picture day

• Club picture day(s)

• School activities (dances, rallies, assemblies)

• Theater/music/dance performances

• Club/organization events

• School holidays

IF YOU HAVE A STAFF, ALSO INCLUDE:

• Staff work days/deadlines

• Cover design due date

ESSENTIAL TO-DOS



all advisers and helpers start here
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4 . DECIDE WHAT TO INCLUDE
A yearbook serves as the official record of the school 
year. Your goal should be to include every student, faculty 
and staff member in the book as many times as possible. 
Although every book is different, here are some items you 
may wish to include:

BASIC COVERAGE:

• Individual portraits for students and faculty

• Club and organization photos

• Sports photos (if applicable)

• Major events of the school year

CHOOSE A COVER
Included in the kit, the Book Looks book provides flexible 
approaches to creating yearbooks, offering predesigned 
covers with optional themes, color palettes and spread 
templates to match. You can also create your own cover. 
Call your CSA to “turn on” your cover template.  Note that 
page 1 is your title page, not your cover.

CONSIDER INCLUDING:
COVER: Theme, book title and year.

SPINE: As space allows, school name, city and state. 
Then, year and volume. Then, book name and theme,  
if it fits. (Doesn’t apply to soft-cover books.)

TITLE PAGE (PAGE 1): Book title, volume number, year, 
school name, complete address, city, state/province, 
postal code. Since you are creating a record of the year, 
it’s important to include some basic information here.

 ONLINE HELP
Access helpful videos through the Learn menu of 
MyHJyearbook.com

eDesign Help

• Master list and name check overview

• Import master list

• Managing production

• Setting up the ladder

• Creating topic pages

eBusiness Help

• Upload name list

• Sales

WHAT IF I  DON’T HAVE A STAFF?
• Recruit parents or other school staff members 

to help you.

• Request assistance from teachers or 
counselors to help proof portrait pages. Their 
input on the correct spelling of names and 
identifying missing students is essential.

• Use Google forms to get great quotes from 
teachers or to conduct surveys with help from  
teachers.

• Consider holding a photo contest to encourage 
student submissions.

• Feature student artwork or poetry.

• Use eShare to ask for photos. (See poster in 
this kit.)

• Consider forming a yearbook committee of 
parent helpers.

WHAT IF YEARBOOK IS A CLUB?
Yearbook clubs can be every bit as productive 
as yearbook classes. However, advisers have to 
motivate students with a force more powerful 
than grades. If you have a small staff, a club can 
supplement the staff’s work or allow students  
with packed schedules to get involved. 

SUGGESTIONS:

• Attend a workshop, summer camp or hold 
boot camp training sessions for staffers.

• Create an incentive system for staffers so they 
can earn a free book, a free ad or perhaps a 
discount on attending a workshop.

• Plan work nights when a deadline is looming. 
Have students bring part of a meal. Taco night, 
ice cream sundae bars, baked potato bars are 
all fun and simple.

• Consider offering membership in organizations 
such as Quill and Scroll for high school as a 
benefit to successful club participation.



LADDER PLANNING

BUILD A L ADDER
In yearbook, the ladder is simply a chart that helps you 
plan what will go on each page and track progress. The 
ladder in this kit shows the maximum number of pages 
for your program. The number of pages is set in four-
page increments. Once you plan out your book, you may 
choose to move it all over to eDesign, if you wish, and 
include staffer assignments and deadlines. 

Refer to How to Yearbook and LearnYBK.com Section Five: 
Covering Your School for more help.

SET UP YOUR LADDER IN EDESIGN

1. Log in to eDesign: Go to myHJyearbook.com. 
Click on the Design menu and choose View Pages. 
You’ll see the outline of your ladder with thumbnail 
previews and information about each spread listed  
in order.

2. Create topics and assign to pages: You’ll want to 
create topic tags for each page in your book. You can 
use these same topics to tag photos to save time. See 
the tutorial in eDesign Help on creating topic tags.

3. Assign topics to pages: See the tutorial in eDesign 
Help on setting up the ladder.

4. Assign deadlines and staff members: If you are 
working with a staff, assign each staffer to their 
specific pages in the ladder. See the tutorial in 
eDesign Help on setting up the ladder.

EDESIGN LADDER

PRINTED LADDER
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STEP 1:  IDENTIF Y THE TOTAL NUMBER OF PAGES IN YOUR BOOK :     pages 

STEP 2: DETERMINE THE TOTAL NUMBER OF PORTRAIT PAGES YOU NEED

ELEMENTARY SCHOOL 

  # of pages for homerooms or classes 

+    # of portrait pages for other teachers, staff and administration

=    TOTAL # OF PAGES NEEDED FOR PORTRAITS

MIDDLE OR HIGH SCHOOL

# of ninth/sixth graders   divided by # portraits per page =    pages

# of 10th/seventh graders   divided by # portraits per page =    pages
 
# of 11th/eighth graders   divided by # portraits per page =    pages

# of 12th graders   divided by # portraits per page =    pages 
  
# of faculty/staff   divided by # portraits per page =    pages

                                     TOTAL # OF PAGES NEEDED FOR PORTRAITS  =   pages

STEP 3: CALCUL ATE HOW MANY YOU HAVE LEF T FOR OTHER TOPICS

  Total pages in your book 

–    Total number of portrait pages

=    PAGES REMAINING FOR ADDITIONAL CONTENT

                          Ex. 64 pages total – 22 portrait pages =  42 pages for additional content

STEP 4 : PL AN FOR IMPORTANT EVENTS
Make a list of all important events you’d like to include, the date they’ll happen, and the number of space 
you want to devote to them.

DATE EVENT  AMOUNT OF SPACE IN BOOK

Ex. 8/24                   First day of school                                  1/2 page

Ex. 9/15    Fall festival                       2 pages

       

       

       

       



PORTRAITS
THE PORTRAIT PROCESS
Portraits are incredibly important, so set aside 
plenty of time to ensure all portraits are included 
in the right grade or class and that all names are 
spelled correctly.

For detailed guidance on the portrait process, click 
Working with Portraits in the sidebar in eDesign 
Help or call the tech support line for assistance at 
877.362.7750.

STEP 1: OBTAIN THE PORTRAIT DISK
Obtain the portrait disk from your school 
photographer. Use the one made specifically for 
yearbook. Some photography companies send a 
CD, and others send a link to download the files.

STEP 2: UPLOAD THE PORTRAIT FILES
In the Portraits section of the eDesign Library, 
you’ll see a button to upload a Portrait CD. If your 
photographer provided you a CD, you’ll need to 
create a ZIP file of the portraits before uploading. 
See the info box on this page for instructions.

STEP 3: FLOW THE PORTRAITS
Use eDesign’s Portrait Flow to place portraits 
and names onto the pages. It flows them in 
alphabetical order in groups you designate (by 
teacher or by grade). Do not put empty portrait 
frames onto pages first. eDesign does it for you. 

STEP 4: PROOF THE PORTRAIT PAGES
Either print the portrait pages or email low-res 
PDFs to teachers or others able to assist: 

• Any misspelled names?

• Any missing portraits? 

• Any portraits with the wrong names?

• Any student listed in the wrong grade/class?

There is also an option to print directory proofs of 
your portraits. See eDesign Help for more info. 

STEP 5: CHANGES IN PORTRAIT LIBRARY
After proofing, make all changes to portraits 
in the portrait section of the Library, NOT on 
the pages. Switch to the Data View. Click into the 
cells to make changes to names and grades. Use a 
consistent format for grades and teacher names. 
Teacher names are only needed if you plan to 
group students by teacher in the book.

STEP 6: RE-FLOW THE PORTRAITS
Open Portrait Flow again. A yellow yield symbol 
will appear next to any group in Portrait Flow that 
needs to be re-flowed. Select the portrait group 
and choose Edit. Portrait Flow remembers all the 
settings from when the section was last flowed. Re-
flowing the section will put the changes you made 
on the pages. Changes made in the Library will 
not go onto the pages until you reflow.

For step-by-step instructions, refer to Working 
with Portraits in eDesign Help.

PORTRAIT FLOW WIZARD
The eDesign Portrait Flow wizard walks you through the process 
of placing portraits and names on pages. Select a page in the 
ladder, then go to Edit > Flow Portraits to launch.

NAME CHANGES IN PORTRAIT LIBRARY
Always make changes to names and grades in the Portrait 
Library. Then reflow the section. If you make changes to 
names on pages, the changes will be lost if you reflow.

FINAL CHECK BEFORE SUBMITTING  
Before you submit any portrait pages, go to the Portrait 
section of the Library and do the following:

1. Use the menu at the top to filter by Unused.

2. Review the unused portraits to confirm they should not 
appear on pages.

3. If you discover any issues, make the needed changes and 
reflow the affected sections.

PREPARING YOUR PORTRAIT CD FOR UPLOADING  
If you receive your portraits on a CD, you’ll need to create a 
ZIP file for uploading to eDesign:

1. Open the CD on your computer. 

2. Select the contents of the CD and copy ALL of the files to 
a folder on your local computer.

3. After the files copy over, right-click on the folder and 
choose Send To > Compressed (Zipped) folder. On Mac, 
control-click the folder and choose Compress.

PORTRAITS PRO TIP

CREATING A ZIP FILE



PUT SOME BLING ON IT.
Consider these enhancements to add value to your yearbook 
and to help generate income for your program. Contact your 
rep for ordering and pricing details.

WORLD YEARBOOK* 
Designed for middle/high school readers, this 
16-page supplement documents events that 
made history during the school year. 

OUR WORLD* 
A scaled down version of 
World Yearbook, intended for 
younger readers and written 
with them in mind, the four-
page Our World supplement 
features photos and captions 
about this year’s most 
important news stories.

* If you purchase either of these for your entire 
order, the supplement will be added following the 
last page of your book. Smaller quantities of Our 
World are also available for purchase and come 
with Kleenstick® self-adhesive tape for easy 
placement in the books when they arrive.

PLASTIC JACKET
Students can keep  
their hard-cover  
yearbooks protected  
and clean for years to  
come with these affordable 
plastic dust jackets.

AUTOGRAPH 
SUPPLEMENTS 
Eight-page autograph 
supplements can be 
added with Kleenstick®  
self-adhesive tape.

NAME IMPRINT
A digital name imprint is a 
book personalization option, 
digitally printed on the cover. 
Printing student names on 
the cover leaves no question 
about whose book it is.

ENGRAVED NAME 
PLATES
Students can order metal 
plates engraved with their 
names to customize their 
yearbook covers. Not 
recommended for soft cover 
books.

BOOK ENHANCEMENTS 
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Special Instructions

HJ
Template

MICC51701L
©2016 Herff Jones, Inc.,

All Rights ReservedEven
Page

8
PB

Job # School

Black Ink Includes Spot Color(s) Process 4-Color (CMYK)

Special Instructions

HJ
Template

Odd
Page

8
1

Job # School

MICC51701R
©2016 Herff Jones, Inc.,
All Rights Reserved

Black Ink Includes Spot Color(s) Process 4-Color (CMYK)

xx

IN A PARADE THROUGH 
OAKLAND, California, Steph 
Curry lifts the Larry O’Brien 
Championship trophy. Curry 
helped lead the Golden State 
Warriors to a third NBA title 
in four years. The 4–0 sweep 
against the Cavaliers ended 
in Cleveland, Ohio. IN THE 
CAPITOL ROTUNDA, visitors 
look on as President George 
H.W. Bush lies in state. Bush 
passed away on Nov. 30, 
2018, less than eight months 
after his wife, former first lady 
Barbara Bush. A service was 
held at Washington National 
Cathedral with the eulogy 
given by 43rd President 
George W. Bush. 

AT BLAST OFF, the Parker Solar Probe 
heads to space from Cape Canaveral Air 
Force Station in Florida. NASA launched 
the spacecraft, and on Jan. 29, 2019, it 
completed the first of 24 planned trips 
around the sun. On Nov. 5, 2018, it moved 
within 15 million miles of the sun, the 
closest flyby ever.

THE BOSTON RED SOX won the MLB 
World Series on Oct. 28 with a 5–1 victory 
over the Los Angeles Dodgers. With the 
ninth win in franchise history, the Red Sox 
shut down the Dodgers in the fifth game of 
the series. Their only loss was the 18-inning 
game three, which lasted more than seven 
hours, making it the longest World Series 
game in history.

T H E  F I N A L 
F R O N T I E R

C H A M P S, A G A I N 
F I N A L L Y

O U R 
W O R L D

2019

our world
news and notes 01



THE eDESIGN WORKFLOW FOR PAGES 
A page in eDesign passes through a few stages before it is 
submitted. These stages help you monitor progress and track 
what’s been done to each page.

 
No edits have been made. The page moves to the 
Edited stage after changes are made and saved on 
the page. Only the people assigned to the page or the 
adviser can edit a page. 

A page remains in this stage while the assigned staff 
members are working. When the page is complete, 
click the Pre-Submit link. 

In this stage, a page can only be unlocked by 
the adviser. Pre-Submit is the final step before 
submitting to the plant.

Always generate a high-res PDF of the final 
version of each page and carefully review it 
before submission (File > High-res PDF). The 
PDF represents what will print, so be sure it 
appears as expected. This is your proof before 
submission.

The adviser has submitted the book to Herff Jones, 
and the page has begun its process at the plant.

Displays on pages with deadlines in eDesign that 
have passed. The eDesign deadlines are set by the 
adviser or editors for production planning and do not 
necessarily reflect when you need to submit the book 
to the plant. 

NEEDS WORK: The Needs Work link on a page in 
the ladder moves a page back to Edit mode so the 
assigned staff members can access it. 

BEFORE YOU SUBMIT
Your cover, personalization and all extras must be submitted at 
the same time as you submit the rest of the book.

Unedited

Edited

Pre-Submit

Submitted
mm-dd-yy ET

Overdue
### days overdue

SUBMIT TING THE BOOK 
When all your pages have been proofed and are in the 
Pre-Submit stage, you’ll see the Submit Book button active 
at the top of the ladder. Click the Submit Book button and 
walk through the submission wizard to transmit your pages 
and order information to the plant.

JANUARY 2020

S M T W T F S

1 2 3 4

5 6 7 8 9 10 11

12 13 14 15 16 17 18

19 20 21 22 23 24 25

26 27 28 29 30 31

FEBRUARY 2020

S M T W T F S

1

2 3 4 5 6 7 8

9 10 11 12 13 14 15

16 17 18 19 20 21 22

23 24 25 26 27 28 29

MARCH 2020

S M T W T F S

1 2 3 4 5 6 7

8 9 10 11 12 13 14

15 16 17 18 19 20 21

22 23 24 25 26 27 28

29 30 31

APRIL 2020

S M T W T F S

1 2 3 4

5 6 7 8 9 10 11

12 13 14 15 16 17 18

19 20 21 22 23 24 25

26 27 28 29 30

MAY 2020

S M T W T F S

1 2

3 4 5 6 7 8 9

10 11 12 13 14 15 16

17 18 19 20 21 22 23

24 25 26 27 28 29 30

31

JUNE 2020

S M T W T F S

1 2 3 4 5 6

7 8 9 10 11 12 13

14 15 16 17 18 19 20

21 22 23 24 25 26 27

28 29 30

JULY 2020

S M T W T F S

1 2 3 4

5 6 7 8 9 10 11

12 13 14 15 16 17 18

19 20 21 22 23 24 25

26 27 28 29 30 31

AUGUST 2020

S M T W T F S

1

2 3 4 5 6 7 8

9 10 11 12 13 14 15

16 17 18 19 20 21 22

23 24 25 26 27 28 29

30 31

SEPTEMBER 2020

S M T W T F S

1 2 3 4 5

6 7 8 9 10 11 12

13 14 15 16 17 18 19

20 21 22 23 24 25 26

27 28 29 30

OCTOBER 2020

S M T W T F S

1 2 3

4 5 6 7 8 9 10

11 12 13 14 15 16 17

18 19 20 21 22 23 24

25 26 27 28 29 30 31

NOVEMBER 2020

S M T W T F S

1 2 3 4 5 6 7

8 9 10 11 12 13 14

15 16 17 18 19 20 21

22 23 24 25 26 27 28

29 30

DECEMBER 2020

S M T W T F S

1 2 3 4 5

6 7 8 9 10 11 12

13 14 15 16 17 18 19

20 21 22 23 24 25 26

27 28 29 30 31

SUBMISSION CALENDAR 
All submission dates are 
Mondays (with the exception of 
the color-coded dates below). 

Books submitted Tuesday 
through Sunday will have the 
ship date calculated based on 
the following Monday. 

The color-coded dates below 
indicate deviations from 
the normal pattern for peak 
submission and ship dates.

SUBMIT DATE           SHIP DATE
Jan. 6, 2020 .............. Feb. 1, 2020 

Jan. 13, 2020 ...........  Feb. 8, 2020

Jan. 20, 2020 .......... Feb. 15, 2020

Jan. 27, 2020 .........  Feb. 22, 2020

Feb. 3, 2020 ...........  Feb. 29, 2020

Feb. 10, 2020 ........  March 7, 2020

Feb. 17, 2020 .......  March 14, 2020

Feb. 24, 2020 ......  March 21, 2020

March 2, 2020 ...  March 28, 2020

March 9, 2020 ........  April 4, 2020

March 16, 2020 .....  April 11, 2020

March 23, 2020 ..... April 18, 2020

March 30, 2020 ....  April 25, 2020

March 31 - April 1, 2020 .................

.................................... May 2, 2020

April 2-6, 2020 ........  May 9, 2020

April 13, 2020 ......... May 16, 2020

April 20, 2020 ........  May 23, 2020

April 27, 2020 ........ May 30, 2020

April 28-May 11, 2020 ....................

...................................June 6, 2020

May 18, 2020 ......... June 13, 2020

May 25, 2020 ........ June 20, 2020

June 1, 2020 .......... June 27, 2020

June 8, 2020 ............. July 4, 2020

June 15, 2020 .........  July 11, 2020

June 22, 2020 .........  July 18, 2020

June 29, 2020........  July 25, 2020

July 6, 2020 .............  Aug. 1, 2020

July 13, 2020............ Aug. 8, 2020

July 20, 2020 .........  Aug. 15, 2020

July 27, 2020.......... Aug. 22, 2020

Aug. 3, 2020 .........  Aug. 29, 2020

Aug. 10, 2020 .........  Sept. 5, 2020

Aug. 17, 2020 ........ Sept. 12, 2020

Aug. 24, 2020 ....... Sept. 19, 2020

Aug. 31, 2020 .......  Sept. 26, 2020

Sept. 7, 2020 ............  Oct. 3, 2020

Sept. 14, 2020 ........ Oct. 10, 2020

Sept. 21, 2020 ........  Oct. 17, 2020

Sept. 28, 2020 .......  Oct. 24, 2020

Oct. 5, 2020 ............ Oct. 31, 2020

Oct. 12, 2020 ...........  Nov .7, 2020

Oct. 19, 2020 .........  Nov. 14, 2020

Oct. 26, 2020 .........  Nov. 21, 2020

Nov. 2, 2020........... Nov. 28, 2020

Nov. 9, 2020 ............ Dec. 5, 2020

Nov. 16, 2020 .........  Dec. 12, 2020

Nov. 23, 2020 ........  Dec. 19, 2020

Nov. 30, 2020 .......  Dec. 26, 2020

Dec. 7, 2020 ..............  Jan. 2, 2021

Your ship date (when the book is complete and ships 
from the plant) is based on when you submit the book. To 
determine when to submit so you get the ship date you 
need, see the 2020 Ship Date Calendar on page 21. 
If you need guidance on when to submit, contact your 
Customer Service Adviser at the plant.

PROOF. PREFLIGHT. SUBMIT.

WHEN A PAGE IS LOCKED

PADLOCK ICON: Only one person can edit a 
page at a time. A padlock indicates the page 
is currently being edited by another person. 
An adviser can “force unlock” a page from 
the ladder if needed.



UNDERSTANDING PREFLIGHT 
Preflight Check in eDesign helps you in the 
proofing process by alerting you to potential 
issues. To run Preflight, go to the File menu 
when a page is open and choose Check Page for 
Problems. 

In Preflight Check, alerts appear in the vertical 
bars to the outside of each page. If you click on the 
alert, eDesign selects the item on the page that the 
alert references. If you hover over an alert, eDesign 
gives a brief description of the issue. The different 
alert types are described below. 

Preflight issues definitions: 

• Invisible content: If the page contains 
frames with no stroke, fill or content, you are 
given the option to delete the empty frames.

• Text across the gutter: Indicates a text 
frame that touches or crosses onto the 
adjoining page. Make sure no  text will be lost 
in the gutter when the book is bound.

• Bleed object: Identifies an object that is very 
near the edge of the page but that does not 
fully bleed off the edge. Bleed elements must 
extend to the outside edge of the 1-pica red 
border around the spread.

• Picture box: Indicates an image that does 
not completely fill the photo frame.

• Image resolution: Appears when a photo’s 
resolution is too low for the highest print 
quality. A DPI warning also appears on the 
image.

• Transparency: Indicates images that have 
transparency applied. These images will not 
be color enhanced at the plant. You do not 
need to fix this. Preflight is just bringing it to 
your attention.

• Embedded image: Identifies non-JPEG 
images. These are not color enhanced at the 
plant. You do not need to fix this. Preflight is 
just bringing it to your attention.

• Placeholder text: Identifies placeholder text 
that has not been replaced with actual text.

ADVANCED SEARCH
The Advanced Search option (see below) can be launched with the link 
at the top right of the ladder. Advanced Search allows you to filter your 
ladder in a variety of ways. Most helpful are the options to filter by a 
deadline and by the student assigned.

SAVE IT FORWARD
After you submit your book, you’ll be given the option to transfer 
templates to the next year’s book. Be aware that all images, portraits, 
fonts, colors and art are transferred along with the template. You also 
have the option to use Save it Forward to transfer other settings such as 
your list of topics, ladder designations, staff, etc. Refer to eDesign Help 
for more information.

ALWAYS REVIEW HIGH-RES PDF  
You generate PDFs from the File menu.  
Use a low-resolution PDF for non-final quick 
proofs. A high-resolution PDF should be 
reviewed by the adviser before submission. 
Viewing a high-res PDF at 300 percent 
gives a good representation of the quality of 
images, etc. Be sure you’re happy with the 
appearance of the high-resolution PDF. The 
PDF represents how the page will print. 

THE IMPORTANCE OF PROOFING
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WORKING WITH IMAGES
Photos create the biggest impact in your yearbook, so you’ll want 
to collect the best. Refer to How to Yearbook and LearnYBK.com 
Section Seven: Cameras and Photos for more help.

PHOTOGRAPHY TIPS
DO set your camera’s image size to the appropriate settings.

• If you set it higher, your image will upload slowly, but you can 
make photos really large in the book.

• If you set it lower, your image will upload quickly, but you 
can’t enlarge photos much in the book.

DO make high-res PDFs and zoom in to 300 percent to see  
image quality.

DON’T take images directly off the internet or from someone’s 
social media site. There could be copyright and resolution issues.

DON’T ignore DPI warnings in eDesign on low-resolution images. 
Either make the image smaller on the page or choose another 
image for that spot instead.

CROWDSOURCE PHOTOS
Promote eShare and make photo requests in the school 
newsletter, via homeroom teachers, email or a note sent home 
with students. Include the eShare code on all advertising.

To set up eShare, go to MyHJyearbook.com > Transfer > Get 
Images from eShare > Preferences.

Use social media to request images of particular events. NOTE: 
You should NOT take images from Facebook or other social 
media sites for use in your yearbook. If you see an image you 
like, you can ask for the original and for permission  
to use it in the book. Also, don’t accept photos texted to you, 
request an email for better quality. Remember files should be 
.jpg or .png. 

eSHARE APP The eShare app is 
available in the App Store or the 
Google Play store.

IMAGE QUALITY 
The triangle means your photo will be fuzzy at the size it is on the 
page. Either choose a different photo or make the photo smaller.

0 0 0 - 1 4 3

1 9 8

2 3 4 5 6 7

 K N O W  Y O U R 
C A M E R A

 Even accomplished 
photographers learn 
through trial and error. 
Try new settings and 
composition techniques  
to improve your work.

1. SHUTTER RELEASE
 Press to take photo

2. POWER BUTTON
 Turns camera on/off

3. MODE DIAL
 Select manual or automatic 

capture settings

4. CONTROL PANEL
 Displays available options

5. BUILT-IN FLASH
 Pops up when  

flash is needed

6. HOT SHOE
 External flash mount

7. VIEWFINDER
 Eyepiece for composing 

photographs

8. LENS RELEASE 
BUTTON

 Used to detach and  
mount lenses

9. FOCUS RING
 Used to bring subject  

into focus

 Read your camera’s owner’s manual 
carefully. It was written specifically for 
your device. 

CENTER OF INTEREST
Make focus obvious. In sports 
photos, the ball should be in the 
frame when possible.
Ex. The dancer’s motion attracts attention to her 
face and expression.

LEADING LINES
Eyes follow pattern to the center 
of interest, especially from 
foreground to background. 
Ex. The stretched bands lead to the ball and the  
boy’s face. Then, the eye moves up to the others. 

BALANCE
All elements work in harmony. 
Balance, both formal or 
informal, intrigues readers.
Ex. The student centered with arms spread 
wide creates formal balance, strengthened by 
the simplicity of the background.

DEPTH OF FIELD
Create depth for perspective. 
Look for overlapping elements. 
Ex. The runner in focus has other competitors 
down the starting line, but the depth of field  
puts them out of focus. 

REPETITION
Patterns draw attention, 
and any break in repetition 
increases interest. 
Ex. The cadets in matching uniforms march in 
rows while the sun breaks through.

FRAMING
Structures, nature and shadows 
can create frames for subjects 
and tell more of the story. 
Ex. Using the outline of the bubble wand,  
the photographer framed the student and  
draws interest to her face.

VARYING ANGLE
Find a low or high angle and  
isolate your center of interest to 
bring interesting perspective.
Ex. High angles fill the frame with peoples’ faces, 
and vary the scale of elements. 

SIMPLICITY
Isolate your subject. Crop before 
you snap. Change perspective 
to reduce background clutter.
Ex. This academics image shows the power of  
a closely cropped shot. It bring focus to her eyes.

PEAK OF EMOTION
That magic moment often 
tells the story. Look for action, 
motion and reaction.
Ex. This photographer zeroed in on an 
excited and expressive player. The result is an 
unforgettable, powerful image.
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P R I N C I P L E S
Learn 10 basics to make  
the most appealing images.

RULE OF THIRDS
Imagine a tic-tac-toe board in 
your viewfinder and capture 
subjects at the intersections. 
Allow subjects to face or move 
into the center of the image to 
bring movement to your work.
Ex. The cadet is framed perfectly and hits two 
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FINDING  focus

PHOTOGRAPHY POSTER found in the kit. 
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ORGANIZING YOUR IMAGES
Advisers and editors create the topic tags for the book. These 
topic tags should correspond to all the content topics in your 
book. Topics can be used in multiple ways to save time and keep 
you organized. 

Advisers and editors can create topics in the Topics panel in the 
Library, in the Topics panel in the Ladder and in the Topics area in 
Book Setup.

TOPICS HELP YOU BUILD YOUR LADDER
Topics are applied to pages in the ladder to designate the content 
of each page. Topic tags can be created by advisers and editors 
in the Topics panel of the ladder. Just create the topic tag (if it 
doesn’t exist) and apply it to the correct pages in the ladder.

TOPICS KEEP YOUR IMAGES ORGANIZED
Topics are like folders — but they’re better. Images can be tagged 
with more than one topic. That way a great image will appear 
for potential use on multiple pages (making the best use of your 
photos). The In Use indicator appears if an image is already used 
elsewhere so you can avoid duplicates. 

SHOWING YOUR TAGGED IMAGES
You can easily show the images tagged with a topic much like you 
open a folder on your computer. 

In the Library or in the Library panel in page 
design there’s a pull-down menu of all the topics. 
Select the topic from the list, and just those 
images appear.

In the Library you can also filter by topic tags by 
clicking the funnel icon to the right of the tag in 
the topic panel.

THREE KINDS OF TAGS
Topic tags are essential for good organization, but you can add 
names and keywords for additional benefits:

1. TOPICS: Tag images with the same page topics you used to 
build your ladder.

2. NAMES: Tag images with names in the master list you 
import into eDesign.

3. KEYWORDS: Tag images with extra information that might 
be helpful to you, especially more specific information (the 
event, the date, the opponent, etc.)

THREE WAYS TO UPLOAD IMAGES TO THE LIBRARY
Before uploading, decide which photos you’re most likely to use.  
It is best to limit uploads to the best photos.

1. IMPORT IMAGES: In eDesign, go to the Library and select 
the Images section. Click the Images button under Import 
Items and follow the prompts. You can upload up to 50 
images at a time.

2. DRAG AND DROP:  In the Images section of the Library, 
click the Quick Image Uploader at the bottom. When that 
window is activated, drag and drop images from your 
computer. They will then upload to eDesign. You can upload 
up to 100 in a single batch. 

3. WHILE EDITING A PAGE:  Open the Images section of the 
Library panel along the right in the page design area. At the 
bottom, click the Get More Candids link. 

 

EX AMPLES OF TAGGED PHOTOS 

TOPICS: Eighth Grade Boys’ Soccer
NAMES: John Richardson
KEYWORDS: against CMS, 7-2

TOPICS: Ms. Smith’s Second Grade
NAMES: May Reddle, CeCe Smith
KEYWORDS: Oak Hill Farm field trip



DESIGNING PAGES
We offer a variety of predesigned layouts in the Book Looks booklet. 
Activate them in the eDesign Library, and drag and drop them on pages. 
There are video tutorials in eDesign Help that show how to activate 
templates and how to put them onto pages. Then you can modify them any 
way you’d like. You may also create your own custom layouts.

STEP 1:  DECIDE WHICH L AYOUTS WORK BEST FOR YOU
We provide several layout collections to choose from. You can even mix 
and match if you wish.

• Book Looks and Go Design — These are two collections of 
professionally designed templates for Herff Jones eDesign. 
Each style has a unique design concept carried out with graphic 
elements, mods, theme suggestions, font suggestions and a color 
palette. (The first five Book Looks are new and will be available in 
eDesign in fall 2019.)

• Square One™ templates and mods — Square One makes it easy 
to employ a contemporary modular design approach, empowering 
you to create a great-looking book that features lots of students. 
Search for Square One in eDesign Help for more information.

• Other template options — The template library also includes 
many starter templates including: Layouts with captions and copy, 
layouts without captions and copy, single-page layouts and more.

STEP 2: ACTIVATE THE COLORS YOU WANT TO USE
Don’t pick colors based on how they look on screen nor based on how 
they look when printed from your desktop printer. These do not accurately 
show what colors will look like when printed on a printing press. 

Instead, look at the colors on the color poster. Each color has a CMYK 
code that matches colors in eDesign (for example, C=0 M=63 Y=73 K=0).

• C is cyan

• M is magenta

• Y is yellow

• K is black 

Make note of the CMYK numbers and activate those colors in Book Setup 
in eDesign. Watch Activating and Creating Colors in eDesign Help for more.

STEP 3: CREATE CHARACTER ST YLES
You’re not required to use character styles, but they can be an easy way 
to apply consistent text formatting in your book. There are video tutorials 
in eDesign’s Help Menu that show how to create and use Character Styles.

EXAMPLE:  AHJ Chantilly Bold  24 pt. CMYK = 43, 12, 17, 87

 Headlines font  pt size  color 

 Copy font  pt size  color 

 Captions  font  pt size  color 

ONLINE HELP
eDESIGN HELP:
MYHJYEARBOOK.COM > LEARN

• Activating a book style

• Activating and managing fonts

• Creating character styles

• Square OneTM

• Activating and creating colors

COLOR POSTER found in the kit. 



DESIGNING PAGES
STEP 4 : IF DESIRED, PL ACE ART ON PAGES
You can put a background on the background layer so it doesn’t interfere 
with other elements on the page. To do this, drag and drop a background on 
an empty area of a page in eDesign. When prompted, confirm you want it to 
be a background. You can remove it by clicking the background tool in the 
tool panel and clicking the clear button at the bottom.

You can also make a image the full spread background. To do this, draw an 
image frame with the shape tool the size of the full spread. Drag and drop 
an image from the Library into the frame. You may need to select the frame 
and choose Object > Send to Back to move it behind any images and text 
already on the page. 

There are videos eDesign Help that show how to activate art in the Library.

STEP 5: ADD HEADLINES, COPY AND CAP TIONS AS DESIRED
eDesign has a time-saving tool called Caption Builder that allows you to 
easily add names in captions. When you tag images with names from the 
master list, it will create text frames with correctly spelled names. Use 
that text frame to add a caption and format its font, color and style as 
you wish. There are video tutorials in eDesign Help that show how to tag 
images with names, how to spell check names in captions and how to use 
Caption Builder to create captions under photos.

FONT BOOK
• More than 500 fonts

• Explanation of types 
of fonts and tips for 
designing with fonts

BOOK LOOKS
• Designs with a “whole-

book look,” including 
covers, layouts, 
graphics, fonts and 
colors (selected 
designs available in  
fall 2019)

• Design style packages 
of borders and 
graphics

• Layouts without color 
or graphic adornments

GRAPHICS   collection
GRAPHICS BOOK  
AVA IL A BL E ONL INE AT  
HERFF.LY/GRAPHICS-BOOKLET

• Additional graphics

• Traditional graphics 
and clip art

• Mascots

• Borders and 
backgrounds

• “Just for Fun” graphics
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TAKE TIME TO TEACH
Use the first weeks of the school year to establish the 
skills and routines to empower students to do the heavy 
lifting in yearbook. Not sure where to start? Begin by 
reading the Welcome section of the printed curriculum. 
Then, access all of the online resources at LearnYBK.com. 
The curriculum bundle includes a scope and sequence 
document, which provides a sketch of how to teach 
yearbook skills. If you’re looking for something a little 
less intense, check out the quick-start guides posted on 
LearnYBK.com. You can get to them by following this link: 
herff.ly/quickstart.

WHAT’S IN A THEME
Think of a theme as a storyline of the year. Themes provide 
visual and verbal unity for yearbooks. While they might not 
be obvious to every reader, a book with a theme presents a 
much better impression than a book without a theme. For 
theme development resources, see Section Four: Theme 
and Voice.

A GOOD THEME IS:
RECOGNIZABLE: Does it make sense as a framework for 
the whole book?

REFRESHING: Is it refreshing, contemporary and 
different?

REPEATABLE: Can it easily appear on each theme spread 
without getting old?

REALISTIC: Is it appropriate to the students at your 
school this year? Does it relate to these students and this 
school year?

RELEVANT: Is it relevant to each section of the book? Can 
the theme introduce each section without being forced? In 
20 years, will this theme seem relevant to the year in which 
it was produced?

If your theme is a storyline, think about what story you will 
tell. Here are some popular choices:

• We have a great reputation or legacy.

• We celebrate the individual as part of a larger group.

• We celebrate our group identity.

• Location. Location. Location.

• We’re all connected.

• Live in the moment.

MAKE YEARBOOK A CULTURE
If being on the yearbook staff is fun and rewarding, if 
students are aware of the skills they are building and able 
to see their own growth, smart students will flock to your 
door. OK, so maybe not flock, but they’ll want to see what 
it’s all about.

ESTABLISH STAFF TRADITIONS
Celebrate birthdays and holidays, recognize good work 
with simple awards. Work nights = food fests.

BE INCLUSIVE
Make room for visual students and verbal students, for 
organized kids who can handle the business side and 
chatty Cathys who just want to interview people. Recruit 
vibrant personalities and the kids sitting quietly in the 
corner. Make yearbook that much more special because 
it’s made for everyone.

EMPOWER YOUR EDITORS
Especially if your editors are returning to yearbook, give 
them teaching assignments. Put them in charge. When 
it comes to eDesign, there’s even a special document for 
editors. It walks them through the major tasks of the year. 
herff.ly/edesigneditors

AT TEND A WORKSHOP
Yearbook workshops are a great way for students to begin 
planning their book during their summer downtime. Go to 
yearbookdiscoveries.com/events for more information.

NEXT-LEVEL GOALS

YBKNVA SUMMER WORKSHOP // Williamsburg, VA



USE YOUR RESOURCES
THE PRINTED CURRICULUM: Available through your rep 
or for order on yearbookdiscoveries.com. The curriculum 
bundle includes 12 booklets that break down the topics 
you need to teach.

LEARNYBK.COM: The online curriculum is divided 
into the same sections as the printed piece. You’ll find 
the supporting documents you need to complete the 
activities. From sample staff contracts and book sales 
forms to vocabulary quizzes, LearnYBK.com is where 
you’ll find resources and make them your own.

TOP FIVE TAKEAWAYS AND POWERPOINTS: On the 
inside front cover of most printed curriculum booklets, 
you’ll find a guide to the five most important points of each 
section. The PowerPoint presentations on LearnYBK.com 
match these takeaways.

VIDEO TUTORIALS: Access our ever-growing library of 
video tutorials through the Learn menu of MyHJYearbook.
com. Find guided notes in Section Nine: Tools of the Trade 
in the online curriculum.

MORE ONLINE RESOURCES: All of the online resources 
are available for a direct download from Google Drive. 
Send a quick email to your rep or to YBK@herffjones.com, 
and we’ll send you the link. Also, answer keys to all of the 
lessons and quizzes are available at herff.ly/answerkeys. 
Cool, huh?

           ADDITIONAL RESOURCES

if you have a staf f, put them to work

17

FOLIO MAGA ZINE
Our magazine to inspire and 

instruct is mailed to your 
school twice each year.

PORTFOLIO:  
THE BEST OF  
HERFF JONES
The annual 
publication 
that brings 
all of our best 
examples 
together in 
one place. 

PODCAST
We talk to 
advisers and 
reps about 
a variety of 
yearbook 
topics. Give it 
a listen. You’ll 
laugh, you’ll 
cry, you’ll  
learn a lot. 

Odd
Page

8
3

WICS0502R

HJ
Template

Special Instructions:
Job #

School

This is an all-color publication

Y B K
F O L

I O . C
O M

H E R F F  J O N E S23 ONEV O L U M E
I S S U E

FRONT COVER

yearbookdiscoveries .com/mind-the-gutter



SALES ASSIST
We run your sales campaign for you. We answer the calls 
and questions, so you don’t have to. We take online and 
phone orders. We process payments. We follow up on 
delinquent checks as necessary. 

Best of all, it’s included in the base price of your book,   
because putting the yearbook together is enough work. 
Let us help you with the business side.
 
Our online accounting software, eBusiness, maintains a 
transaction register of online and in-school book and ad 
sales in one database.
 
That makes generating and printing reports to check and 
share your sales status as easy as a click.

HOW IT WORKS

1. Targeted email campaign. The campaign begins in 
August and follows best practices for email sales. 
But, you can enroll when you are ready, and your list 
will be included in the next scheduled send.  

2. Once parents make a purchase, they are excluded 
from future communications about book and ad 
sales. If you sell books in school and enter sales in 
eBusiness, those buyers will also be excluded from 
future emails. Make sure your eBusiness sales are  
up to date. 

 
3. Matching posters are included in the kit so you can 

coordinate your in-school marketing with the email 
campaign. If you run out of posters, order more from 
your CSA. 

 
4. We provide campaign-branded web banners for 

your school’s and staff’s websites. Give these to your 
programmers and ask them to link the image to your 
Yearbook Order Center page.  
 

FOLLOW THIS FORMULA TO FORMAT THE URL: 

yearbookordercenter.com/index.cfm/job/XXXX.  
Replace the XXXX with your job number. 

 
 

HOW TO ENROLL

1. Get a list of parents’ email addresses. (Mailing 
addresses are optional; see p. 4 for more.)

2. Contact your rep to enroll and upload your list. 

Keep your eBusiness records updated for best results. 

SEND AND SELL
eDesign users can generate their own customized email 
campaigns. It pulls from your uploaded name and email 
list to send reminders to parents who have not purchased 
a book. Use pre-designed email messages or make your 
own. Click, click and you’re done. Check out the video 
tutorials under the eDesign Help menu. Don’t forget to 
enter your in-school sales into eBusiness.

ADDITIONAL TOOLS TO HELP YOU SELL 
Customize your marketing and sales efforts to fit your 
school. While we have included samples in this kit, 
additional resources are available on yearbookdiscoveries.
com under the Shop tab.
 
Posters, banners and yard signs 

• Book sales, 010-980, 010-982

• Senior ad sales

• Prices are going up

• Distribution day

• General yearbook awareness

• Last chance for yearbooks, 010-986

Letterhead, Create and Share
Order a stash of letterhead to send letters to businesses 
for ad renewals. Use our Create and Share function in 
eDesign to print fliers and pre-designed templates. Check 
out the video tutorials under the eDesign Help menu.

SELL IT



SALES POSTERS 000-322 through 324, three designs available, found in the kit 
and available for order on yearbookdiscoveries.com

SALES BANNERS 010-980 through 987, seven designs available
Order at yearbookdiscoveries.com

SALES BANNERS 010-980 through 987, seven designs available
Order at yearbookdiscoveries.com

YARD SIGNS 010-521, 522
Order at yearbookdiscoveries.com

ORDER  
TODAY

STATIONERY 000-088, 000-024
Order at yearbookdiscoveries.com
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Y E A R B O O K  O R D E R  F O R M

School/organization name: 

Principal’s name:  Adviser’s name:  Adviser’s email:   

School address:  City:  State:  Zip: 

Phone:  Number of classrooms:  Copies:  Pages:  

We would like Herff Jones to print our all color yearbook based on the following information:

Determine per book base price: Number of books:  Number of pages:  = Per book price: 

To determine contract base price BEFORE book add-ons: Per book price:  x number of books:  = Contract base price 

ADD-ON ITEMS:
 Gloss lamination on all of our soft covers (+) price per book  x number of books  = + 

 Matte lamination on all of our soft covers (+) price per book  x number of books  = + 

 Upgrade to gloss laminated hard covers (+) price per book  x number of books  = + 

 Upgrade to matte laminated hard covers (+) price per book  x number of books  = + 

  Split covers: one-time fee of $101 to mix soft and hard cover books  (+) one time fee = 

   Add  hard covers to our order (+) price per book  x number of books  = + 

 Upgrade to 100# gloss paper (+) price per book  x number of books  = + 

 Upgrade to 100# matte paper (+) price per book  x number of books  = + 

ADDITIONAL ITEMS:
 Add digital name imprints (minimum 25)  (+) price per imprint  x number of imprints  = + 

 Add name plates (minimum 10)  (+) price per plate  x number of plates  = + 

 Choose name plate color:   Silver   Gold 

 Add plastic jackets   (+) price per jacket  x number of jackets   = 

 Add Our World  copies  = 

   Sold individually @  each OR (+) price per copy  x number of copies  = + 

   Sewn into every book ordered @  each    (+) price per copy  x number of books  =  + 

 Add World Yearbook 

   Sewn into every book ordered @  each    (+) price per copy  x number of books  =  + 

  Total price after additions + 

  Total per book price  + BOOK SUBMISSION AND DELIVERY: 
We would like our kit to arrive on 

Our book needs to ship on Saturday, 

Our material must be submitted by Monday, 

Allow 4 weeks prior to ship date if your book ships before May. If your book will ship in May, allow 5 weeks from submission to delivery. Shorter schedules 
may be purchased. Kit materials will be shipped to the school address indicated above. 

Please allow 2-7 days for shipping. Plan your distribution event accordingly. Standard ground shipping is included. Expedited shipping is available 
at an additional cost.

TERMS AND CONDITIONS:
Years of printing:      2019      2020      2021      2022      2023

All specifications and prices are subject to the approval of both the school and Herff Jones, LLC, on an annual basis. We understand the submission of this order form is an obligation 
to print our yearbook as indicated above. We may change the number of copies and pages prior to, or upon submission of materials for printing; however, changes will result in a 
change in price. Upon receipt of our materials, we will receive an invoice for the full amount of this order form plus any increases or decreases due to changes in specifications. The full 
amount of the invoice is due upon receipt and must be received at Herff Jones prior to the shipment of our completed yearbooks. Standard ground shipping of the books is included in 
the cost. Tax is additional. We understand that copyrighted materials may not be used in the creation of our yearbook without the express written consent of the copyright owner. Herff 
Jones has created proprietary artwork, borders and backgrounds that may be used in the creation of our yearbook. We agree to hold Herff Jones, subsidiaries and affiliates harmless 
for all editorial content associated with the printing of our yearbook. I, the undersigned authorized agent of the school or organization indicated above, agree in full to the “Terms and 
Conditions” of this order. This agreement shall be effective when signed below or in counterpart, and photocopy, facsimile, electronic or other copies shall have the same effect for all 
purposes as an ink-signed original.

Authorized signature:  Title or position:  

Print name:  Date:  

Email:  Herff Jones representative: 

SAMPLE



JANUARY 2020

S M T W T F S

1 2 3 4

5 6 7 8 9 10 11

12 13 14 15 16 17 18

19 20 21 22 23 24 25

26 27 28 29 30 31

FEBRUARY 2020

S M T W T F S

1

2 3 4 5 6 7 8

9 10 11 12 13 14 15

16 17 18 19 20 21 22

23 24 25 26 27 28 29

MARCH 2020

S M T W T F S

1 2 3 4 5 6 7

8 9 10 11 12 13 14

15 16 17 18 19 20 21

22 23 24 25 26 27 28

29 30 31

APRIL 2020

S M T W T F S

1 2 3 4

5 6 7 8 9 10 11

12 13 14 15 16 17 18

19 20 21 22 23 24 25

26 27 28 29 30

MAY 2020

S M T W T F S

1 2

3 4 5 6 7 8 9

10 11 12 13 14 15 16

17 18 19 20 21 22 23

24 25 26 27 28 29 30

31

JUNE 2020

S M T W T F S

1 2 3 4 5 6

7 8 9 10 11 12 13

14 15 16 17 18 19 20

21 22 23 24 25 26 27

28 29 30

JULY 2020

S M T W T F S

1 2 3 4

5 6 7 8 9 10 11

12 13 14 15 16 17 18

19 20 21 22 23 24 25

26 27 28 29 30 31

AUGUST 2020

S M T W T F S

1

2 3 4 5 6 7 8

9 10 11 12 13 14 15

16 17 18 19 20 21 22

23 24 25 26 27 28 29

30 31

SEPTEMBER 2020

S M T W T F S

1 2 3 4 5

6 7 8 9 10 11 12

13 14 15 16 17 18 19

20 21 22 23 24 25 26

27 28 29 30

OCTOBER 2020

S M T W T F S

1 2 3

4 5 6 7 8 9 10

11 12 13 14 15 16 17

18 19 20 21 22 23 24

25 26 27 28 29 30 31

NOVEMBER 2020

S M T W T F S

1 2 3 4 5 6 7

8 9 10 11 12 13 14

15 16 17 18 19 20 21

22 23 24 25 26 27 28

29 30

DECEMBER 2020

S M T W T F S

1 2 3 4 5

6 7 8 9 10 11 12

13 14 15 16 17 18 19

20 21 22 23 24 25 26

27 28 29 30 31

SUBMISSION CALENDAR 
All submission dates are 
Mondays (with the exception of 
the color-coded dates below). 

Books submitted Tuesday 
through Sunday will have the 
ship date calculated based on 
the following Monday. 

The color-coded dates below 
indicate deviations from 
the normal pattern for peak 
submission and ship dates.

SUBMIT DATE           SHIP DATE
Jan. 6, 2020 .............. Feb. 1, 2020 

Jan. 13, 2020 ...........  Feb. 8, 2020

Jan. 20, 2020 .......... Feb. 15, 2020

Jan. 27, 2020 .........  Feb. 22, 2020

Feb. 3, 2020 ...........  Feb. 29, 2020

Feb. 10, 2020 ........  March 7, 2020

Feb. 17, 2020 .......  March 14, 2020

Feb. 24, 2020 ......  March 21, 2020

March 2, 2020 ...  March 28, 2020

March 9, 2020 ........  April 4, 2020

March 16, 2020 .....  April 11, 2020

March 23, 2020 ..... April 18, 2020

March 30, 2020 ....  April 25, 2020

March 31 - April 1, 2020 .................

.................................... May 2, 2020

April 2-6, 2020 ........  May 9, 2020

April 13, 2020 ......... May 16, 2020

April 20, 2020 ........  May 23, 2020

April 27, 2020 ........ May 30, 2020

April 28-May 11, 2020 ....................

...................................June 6, 2020

May 18, 2020 ......... June 13, 2020

May 25, 2020 ........ June 20, 2020

June 1, 2020 .......... June 27, 2020

June 8, 2020 ............. July 4, 2020

June 15, 2020 .........  July 11, 2020

June 22, 2020 .........  July 18, 2020

June 29, 2020........  July 25, 2020

July 6, 2020 .............  Aug. 1, 2020

July 13, 2020............ Aug. 8, 2020

July 20, 2020 .........  Aug. 15, 2020

July 27, 2020.......... Aug. 22, 2020

Aug. 3, 2020 .........  Aug. 29, 2020

Aug. 10, 2020 .........  Sept. 5, 2020

Aug. 17, 2020 ........ Sept. 12, 2020

Aug. 24, 2020 ....... Sept. 19, 2020

Aug. 31, 2020 .......  Sept. 26, 2020

Sept. 7, 2020 ............  Oct. 3, 2020

Sept. 14, 2020 ........ Oct. 10, 2020

Sept. 21, 2020 ........  Oct. 17, 2020

Sept. 28, 2020 .......  Oct. 24, 2020

Oct. 5, 2020 ............ Oct. 31, 2020

Oct. 12, 2020 ...........  Nov .7, 2020

Oct. 19, 2020 .........  Nov. 14, 2020

Oct. 26, 2020 .........  Nov. 21, 2020

Nov. 2, 2020........... Nov. 28, 2020

Nov. 9, 2020 ............ Dec. 5, 2020

Nov. 16, 2020 .........  Dec. 12, 2020

Nov. 23, 2020 ........  Dec. 19, 2020

Nov. 30, 2020 .......  Dec. 26, 2020

Dec. 7, 2020 ..............  Jan. 2, 2021



Breathe in. Breathe out. Then, read this book. It’s OK, we know it’s overwhelming.  

This is where we try to break it down and make it easier. 

D O N ’ T  W O R R Y,  Y O U ’ L L  N E V E R  Y E A R B O O K  A L O N E .

0 0 0 - 2 8 3


